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1.  INTRODUCTION 

Overview 

Today's energy-efficient windows can dramatically lower the heating and cooling costs associated with 

windows while increasing occupant comfort and minimizing window surface condensation problems.  

However, consumers are often confused about how to pick the most efficient window design for a 

commercial building. Product information typically offers window properties:  U-factors or R-values, 

Solar Heat Gain Coefficients or Shading Coefficients, and air leakage rates. However, the relative 

importance of these properties depends on site- and building-specific conditions. Furthermore, these 

properties are based on static evaluation conditions that are very different from the real situation a 

window will be used in.  

A computer tool such as COMFEN can help architects and builders pick the most energy-efficient and 

cost-effective window for a given application. It calculates heating and cooling energy use and associated 

costs as well as peak heating and cooling demand for specific window products. Users define a specific 

"scenario" by specifying the building type, geographic location, orientation, and window configuration. 

Users also specify size, shading, and thermal properties of the window they wish to investigate.  

Update information, future releases, and program information about COMFEN and other software tools 

(such as WINDOW, THERM, and Optics) from the Windows and Daylighting Group at LBNL can be 

found on the World Wide Web at URL: http://windows.lbl.gov, in the Software section. To obtain 

COMFEN, WINDOW, or THERM, check the web site for the current downloadable version. 

 

http://windows.lbl.gov/
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2.  QUICK START 

2.1.  Getting started 

 Install the COMFEN program (see Chapter 3, "Installation"). 

 When the program is installed, double click on the COMFEN4 icon. 

 

Figure 2-1. Click on the COMFEN icon in the Programs/LBNL Software list. 

 The Startup Menu screen that appears allows you to either start a new project or open existing 

projects. There are a few example projects in COMFEN, which are listed under Recent Projects. 

Projects are collections of “scenarios” or façade designs, that can be compared.  

 

Figure 2-2. The Startup Menu screen allows you to create a new project or open already defined projects. 
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2.2.  Quick Tour of COMFEN 

To take a tour of the program, we will start by opening an existing project, West Shading Example. 

2.2.1.  Main Screen 

Below is the main screen when you first open the program. Following discussions will explain in more 

detail each section on this screen. The program opens with the Overview / Summary results tab being 

displayed. 

Figure 2-3. The Overview / Summary View. 

 

Project 
Explorer 

Results 
tabs 

Menu 

Toolbar 

Project 
Name 

Location 
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Project Explorer 

The Project Explorer is the primary navigation tool in the Project. In the Project Explorer, there are two 

tabs, Scenarios and Libraries. 

Figure 2-4. The Project Explorer. 

Scenarios The Scenarios tab shows a list of all the Scenarios in the current Project 

Libraries The Libraries tab has three subtabs: 

 Window Library Tab:  this shows the records in the Window Library. There is 
one default window. You can highlight a window and drag it onto the façade in 
the Edit Scenario View. 

 Glazing System Tab:  this shows the records in the Glazing System Library. 
You can highlight a glazing system and drag it onto a window in the Edit 
Scenario View. 

 Shading System Library Tab:  this shows the records in the Shading System 
Library. You can highlight a shading system and drag it onto a window in the 
Edit Scenario View. 

Figure 2-5. The Libraries Tab subtabs. 

Window Library Tab 

Glazing System Library Tab 

Shading System Library Tab 

The column width can be 
adjusted by pulling the right 
hand column boundary to 
the left or right 

Clicking on a 
column header 
causes the list to 
be sorted by that 
column. The 
default sort is ID 

The entire Explorer 
column can be 
resized by pulling 
this icon to the left or 
right 

This icon toggles the 
details (everything 
except ID and Name) 
to show or not to show  

The Libraries tab has three subtabs: 
- Window Library 
- Glazing System Library 

- Shading System Library 

List of Scenarios 
in the current 
project 

List of items 
in each of 
the 
Libraries 

Right click on a 
Scenario for a list of 
actions that can be 
applied to that 
Scenario 
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Scenario Visualization 

Under the Comparison Tab, you can show up to four of the scenarios by dragging them from the Project 

Explorer Scneario tab to the upper right part of the screen. Highlight the desired Scenarios in the 

Scenarios tab and drag your mouse to the right.  

Figure 2-6. Highlight up to four scenarios and drag them to the right under the Comparison tab. 

Figure 2-7. The scenarios will be displayed in “3D” and results, if they exist, will be shown below each. 
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The Scenario Visualization section of the main screen shows the geometry of any Scenarios in the Project 

Explorer that you have dragged into the Visualization section of the screen. They do not have to be 

simulated to be in the Visualization section, but results will only show in the Results section if they are 

simulated. 

Figure 2-8. The elements of the Scenario Visualization. 

 

ID and Name of 
the Scenario 

Clicking the X will 
close the 
Visualization for this 
scenario Line indicates 

Project North 
 
White arrow 
indicates 
orienation of this 
scenario 

Zoom control 
allows zooming 
of the scenario 
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2.2.2.  Menu 

 

Figure 2-9. The COMFEN menu options. 

The COMFEN menu options are: 

COMFEN The menu options are: 

 About COMFEN: This option shows the program version 

 Preferences: Controls various settings in the program 

 Hid COMFEN  

 Quit 

Project The File menu is used to control projects and general program options 

 New Project: Starts a new project, opening up the Project Properties dialog box 

 Open Project: Opens a list of projects that are in the current database 

 Close Project: Closes the current project 

 Project Properties: Opens the Project Properties dialog box, which contains the 
Project Name, Building Type, Project North and Location 

 Delete Projects: Allows you to delete projects from the database 

 Import Project Definition from CSV file: Allows you to import projects from a 
CSV text file. All projects must be closed for this option to be active 

Scenarios The Scenarios menu is used to control the Scenarios within Projects. 

 Create Scenario: Creates a new scenario within the currently opened project 

 Duplicate Scenario: Makes a copy of the highlighted scenario 

 Import Scenario from Project: Shows all the scenarios in all the projects in the 
current database, and allows import of those scenarios into the current project 

 Delete Scenario: Deletes the highlighted scenario 

 Rename scenario: Renames the highlighted scenario 

 Export scenario output data to CSV: Exports the Annual Energy Use results for 
all the scenarios in the currently open project to a CSV file, which can then be 
opened in a spreadsheet program. 

 Export compared scenarios images to PNG 

 Calculate All: Calculates the results for all the scenarios in the currently open 
project 

 Calculate Selected: calculates the results for the highlighted scenarios 

Libraries The Libraries menu is used to access all the Libraries 

 

Help The Help menu is used to view the program version number as well as the program 

Help file. 
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2.2.3.  Toolbar 

Figure 2-10. The COMFEN Toolbar. 

 

Toolbar 
Icon 

Description Menu / Choice 

 Library Libraries / View All Windows 

 Project Details File / Project Properties 

 Add New Scenario to Project Scenarios / Create Scenario 

 Import Scenario into Project Scenarios / Import Scenario 

 Calculate energy use for selected scenarios Scenarios / Calculate Selected 

 Add a window to the current scenario Scenarios / Add Window to 

Scenario 

 Add a wall shade (fin or overhang) to the current scenario Scenarios / Add Exterior Shade 

to Scenario 

 Add a Glazed Wall Assembly to the current scenario  

 Show Glazing System and Shading System IDs on the 

Scenario graphic 
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(fin / 
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Import 
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Calculate 
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2.3.  Open an Existing Project 

When you first open a Project that is already in the database, the Project Explorer is shown on the left side 

of the screen and the Overview Tab is shown on the right side of the screen. If the scenarios have not been 

calculated, there will be yellow triangles to the left of the scenarios and there will not be graphs in the 

Summary tab. 

Figure 2-11. The Overview screen, which appears when you open an existing project. 

You can calculate the results at this point, and they will appear in the Summary tab. To calculate the 

results, highlight as many scenarios as you want to calculate, and click on the Lightning Bolt toolbar, or 

right click and choose the Calculate Enery Use option. 

Yellow 
triangles 
indicate that 
results need 
to be 
calculated 

The Summary section is 
blank because the 
scenarios have not been 
calculted 
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Going to the Comparison tab will allow you to see the Scenario Visualization view, but it will be blank 

until you highlight the scenario from the Scenario List on the left, and drag it them to the right.  

Figure 2-12. Drag scenarios to the right in the Comparison tab. 

Then you will be able to see the “3D” versions of the scenarios, but there will still not be results until the 

scenarios are calculated. 

Figure 2-13. The 3D visualizations are shown in the Comparison tab. 
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If the scenarios have a triangle icon to the left, this means that they do not have current results (and 

therefore the Results Section will be blank) and must be simulated. 

Figure 2-14. The yellow triangle icon to the left of the scenario means it needs to be calculated 

To calculate the results, select as many scenarios as desired, then click the lightning bolt tool bar button, 

and the program will start to run the Energy Plus simulation program for each scenario. 

Figure 2-15. Highlight the scenarios to be calculated and press the Lightning Bolt toolbar button. 

As the calculations are proceeding, a status box will appear. 

Figure 2-16. A status bar will appear as the scenarios are calculated. 

 

Select all the scenarios 
that need to be simulated 

Click the Calculate icon and Energy Plus will 
start simulating the scenarios 

This icon means that the 
results are not current and 
they must be calculated 

As the calculations proceed, a 
status bar appears 
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 When the calculations are finished, the results will appear in the Results Section 

Figure 2-17. When the results have been calculated, the results will display under the Comparison tab. 

 

 

 

 

When the 
calculations are 
finished, the results 
will appear in the 
Results Section 
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2.3.1.  Viewing the Scenario Details 

In order to view the details of a scenario, you need to open the Edit Scenario Viewby double clicking on 

the graphic of the scenario. 

Figure 2-18. The Scenario tab on the Edit Scenario View. 

Double click on the Scenario 
Visualization to open the Edit Scenario 
View, which will show the details of the 
scenario 
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Edit Scenario View 

The Edit Scenario View allows you to enter information about the geometry of the space to be modeled, 

the lighting controls, the lighting and equipment loads, and the number of people in the space. 

Scenario Tab 

The scenario tab contains the title of the scenario, as well as information about the geometry and loads of 

the scenario. 

Figure 2-19. The Scenario tab on the Edit Scenario View. 

The Geometry section 
contains the dimensions 
of the scenario, as well as 
the orientation of the front 
of the facade 

The Environment section 
contains information about 
lighting and glare controls, as 
well as loads for lighting, 
equipment and people 

The Windows 
tab lists the 
properties of 
each window 

The Wall Shades tab lists the 
properties of the overhangs and 
fins 

Click Done 
to close this 
view and 
return to the 
Scenario 
Visualization 
view  

The Glazed Wall tab lists 
the properties of the 
Glazed Wall Assembly if 
it is defined 
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Windows Tab 

The Windows Tab shows a list of all the windows on the façade. Double click on any window in either 

the list or the graphic and the Edit Window dialog box appears, which allows you to view and edit the 

window information.  

 Figure 2-20. The Window tab and the Edit Window dialog box 

To see (and edit) the details of a 
particular window, double click on 
the window in either the list or the 
graphic, which causes the Edit 
Window dialog box to appear 

The Edit Window dialog box 
allows the properties of the 
window to be viewed or edited. 

Click on the Glazing 
System, Shading System 
and Frame Type pulldown 
lists to select the 
appropriate options. 

Click Done to 
close the dialog 
box and return 
to the Edit 
Scenario View 

Window 
name 

Click this icon  
to view the 
Glazing and 
Shading System 
IDs 
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Edit Window dialog box 

The Edit Window dialog box allows you to view and edit all the information pertaining to the window.  

 

Figure 2-21. The Basic Info tab on the Edit Window dialog box. 

Sill Height 

Window Height 
(outside frame to 
outside frame) 

Distance from Left wall  
(from Left hand edge of frame) 

Window Width 
(outside frame to 
outside frame) 
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Wall ShadesTab 

The Wall Shades Tab shows a list of all the overhangs and fins on the façade. Double click on any 

overhang or fin in either the list or the graphic and the Edit Wall Shade dialog box will appear, which 

allows you to view and edit the window information.  

Figure 2-22. The Wall Shades tab and Edit Wall Shade dialog box. 

To see (and edit) the details of a particular 
overhang or fin, double click on the overhang or fin 
in either the list or the graphic. This will cause the 
Edit Wall Shade dialog box to appear. 

The Edit Wall Shades dialog box allows the 
details of the overhang or fin to be viewed 
and/or edited. 

Click Done to close 
the dialog box and 
return to the Edit 
Scenario View 
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2.4.  Creating a New Project 

Click on the New Project choice under Create 

 Figure 2-23. Click on New Project to start a project. 

The Create COMFEN Project will appear. On the left are different categories of information to be defined. 

Highlight each category to define those properties 

 Figure 2-24. Fill in the Create COMFEN Project dialog box with the appropriate information. 

Click on New 
Project to 
start a project 

Project Name (required) 

Project Description (optional) 

Project North 
(for offset from cardinal orientations) 

Location 
Select from the pulldown list 

Informational 
Cannot be changed at this time 

Default wall construction 
Can be changed in the Location Library 

or on the Scenario Edit screen 
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2.4.1.  Defining Scenarios 

When you are starting a new Project, there are no scenarios defined. To define a new scenario, go to the 

Scenarios menu and select Create Scenario 

 Figure 2-25. Creating a new scenario.  

In the Scenarios menu, 
click on the Create 
Scenario choice 

Click on the Add New 
Scenario toolbar button 

OR 

The Create New 
Scenario dialog box will 
appear. 

Enter the appropriate 
information. 

Click OK when you are finished, 
and the new scenario will 
appear in the Project Explorer 
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2.4.2.  Edit Scenario 

To edit the scenario (so that you can add windows, shades, etc), do one of the following: 

 Double click on the scenario name in the Project Explorer to open the Edit Scenario View 

OR 

 Highlight the scenario (single click) and drag it to the right with your mouse. This will cause 

a graphic image of it to appear on the right in the Scenario Visualization section. Then double 

click on the graphic to open the Edit Scenario View. 

Figure 2-26. The two ways to open the Edit Scenario View from the Project Explorer 

Double click on the 
Scenario name in 
the Project 
Explorer and the 
Edit Scenario View 
appears 

Highlight the Scenario 
name, then drag it to 
the right, so that the 
graphic Scenario 
Visualization appears Then double click on the graphic 

Scenario Visualization, and the Edit 
Scenario View appears 
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2.4.3.  Add Windows 

There are several ways to add a window to a scenario: 

 From the Project Explorer, select the Libraries tab, Window Library icon, and drag a window to the 

facade 

OR 

 From the Edit Scenario Window tab, click on the  button and the enter the appropriate 

information in the New Window dialog box. From this dialog box you can also define the 

Glazing System, Shading System and Frame Type from the appropriate tabs. 

Click on the 
Libraries tab 

Click on the 
Window icon 

Highlight the 
desired window 
and drag it to the 
façade wall 

When the window is 
on the wall, it can be 
moved by clicking on it 
and dragging it to the 
desired position 

The window can also 
be resized by clicking 
on the lower right 
corner and dragging it. 

To add a window, click 
on the “+” button and the 
New Window dialog box 
will appear 
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OR 

 From the Scenarios menu, click on the “Add Window to Scenario” menu choice, which will 

display the New Window dialog box. From this dialog box you can also define the Glazing 

System, Shading System and Frame Type from the appropriate tabs. 

Figure 2-27. View a Façade that is already defined in the Façade Library. 



2.  QUICK START 

2-22 DRAFT – AUGUST 2011 COMFEN 4.0 

Defining the Glazing System for the Window 

There are several ways to define or change a glazing system for a window: 

 From the Project Explorer, select the Libraries tab, Glazing System Library icon, highlight 

the desired glazing system, and drag it to the window. 

OR 

 When defining the window, in the New Window dialog box, click on the Glazing System tab 

and the records in the Glazing System Library will be displayed in a list. Highlight the 

desired glazing system and click the Add button. 

Click on the 
Libraries tab 

Click on the 
Glazing 

System icon 

Highlight the 
desired Glazing 
System and drag 
it to the window 

When you hover over 
the “i” Information icon 
will show the new 
glazing system. 

All the records 
in the Glazing 
System Library 
will show in 
this list  

Select the Glazing 
System tab 

Highlight the desired 
Glazing System  

Click the 
Add button 
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OR 

 Click on the Add Window to Scenario toolbar button           and the New Window dialog box 

will open. 

OR 

 Double click on the window to open the Edit Window dialog box. Click on the Glazing 

System tab to define or change the glazing system for the window. Highlight the desired 

glazing system and click the Done button. 

Double click on the 
window to open the 
Edit Window dialog 
box 

Click on the Glazing System tab to see 

the Glazing System Library list 

Highlight the desired glazing system and 
click on the Done button 

Click on the Add 
Window toolbar icon 
and the New Window 
dialog box will open 
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OR 

 In the Edit Scenario View, click on the Window tab, double click on the desired window and 

the Edit Window dialog box will appear. 

In the Edit Scenario view, click on 
the Windows tab to view a list of 
the windows on the facade 

Highlight the desired window and 
double click to open the Edit 
Window dialog box. 
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Windows Tab on Edit Scenario View 

The Windows Tab shows a list of all the windows on the façade. Double click on any window in either 

the list or the graphic and the Edit Window dialog box appears, which allows you to view and edit the 

window information.  

Figure 2-28. The Window tab and the Edit Window dialog box 

To see (and edit) the details of a particular 
window, double click on the window in either 
the list or the graphic, which causes the Edit 
Window dialog box to appear 

The Edit Window dialog box allows the 
properties of the window to be viewed 
or edited. 

Click on the Glazing System, 
Shading System and Frame 
Type tabs to see the details of 
those window components. 

Glazing system 
name 
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Edit Window dialog box 

The Edit Window dialog box allows you to view and edit all the information pertaining to the window. 

There are several tabs in this dialog box: 

Basic info The window dimensions and position in the wall  

Figure 2-29. The Basic Info tab on the Edit Window dialog box. 

The Frame Width is the frame dimension when looking at the frame in elevation. 

Figure 2-30. The Frame Width. 

The Frame Setback is the distance from the outside wall that the window is inset into the frame. 

Figure 2-31. The Frame Setback. 

The Window Area is the area of 
the window including the frame. 

The Vision Area is the area of the 
glazing system inside the frame. 

Frame Width 

Outside Inside 

Frame 
Setback 
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Glazing System The glazing system that is selected for the window 

Figure 2-32. The Glazing System tab on the Edit Window dialog box. 

The highlighted 
glazing system is 
the one selected 
for this window 
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Shading System The shading system (such as venetian blind, shade, exterior screen) for the window 

Figure 2-33. The Glazing System tab on the Edit Window dialog box. 

Frame Type The frame type for the window. 

Figure 2-34. The Glazing System tab on the Edit Window dialog box. 

In this example, 
there is not a 
shading system 
selected, so no 
shading system in 
the list is highlighted 

The highlighted 
frame is the one 
selected for this 
window 
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2.4.4.  Add Wall Shades (Overhangs and Fins) 

To add overhangs and fins to the scenario, go to the Wall Shades tab in the Scenario Edit view, and click 

on the + button. A dialog box will appear which allows you to define overhangs and fins.  

Figure 2-35. Defining an overhang or fin. 

Step 1: Go to the 
Wall Shades tab 

Step 2: Click on 
the + button 

Step 3: Fill in the 
information about 
the shade 
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3.  INSTALLATION 

3.1.  Hardware Requirements 

First, make sure your computer system meets these specifications: 

 At least 16 MB of random access memory (RAM), configured as extended memory. 32 MB of RAM is 

preferred for optimum operation. 

 Microsoft Windows XP™, Windows Vista™ or Windows 7™. 

 Hard disk drive with at least 100 megabytes of available disk space. 

 Monitor and mouse. 

3.2.  Setup 

The installation program can be downloaded from the LBNL website at 

http://windows.lbl.gov/software/comfen 

Once you have downloaded the installation program, follow these steps to install the program: 

1. Using Windows Explore, browse to where the installation file was downloaded and double click on it. 

 

Figure 3-1. Double click on the downloaded installation file. 
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2. A Welcome window will display. Click the Next button to proceed with the installation, or Cancel to 
stop. 

 

Figure 3-2.  The initial COMFEN Welcom window. 
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3. The Software License Agreement window will display next. Read through the license and make sure 
you agree to all the terms before proceeding. To proceed with the installation, click on the Yes button, or 
click on No to stop.  

 

Figure 3-3.  The COMFEN License Agreement window. 
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4. The Ready to Install the Program window will display next.  Press the Install button to begin the 
installation. 

 

Figure 3-4.  Ready to Install the Program screen.  
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5. The next screen to display is the Setup Status screen, which shows the files being installes. 

 

Figure 3-5.  The Setup Status screen shows the files being installed. 
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6. When the installation is complete, the InstallShield Wizard Complete screen will be displayed. Press 
Finish to finalize the installation. Sometimes this screen will appear, but you can’t click the Finish 
button. In this case, click on another area of the screen, then click back to this screen and you should be 
able to click on the Finish button. 

 

Figure 3-6.  The InstallShield Wizard Complete screen will display when the installation is finished. Press the Finish button to 

finalize the installation. 

 

7. Setup will automatically put a COMFEN Icon in the Programs menu under the LBNL Software group. 

 

Figure 3-7.  Program icon to run COMFEN. 
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3.3.  Running COMFEN  

To run COMFEN, go to the Programs menu, single click on the LBNL Software group, and single click on the 

COMFEN icon. Additionally, there may be a shortcut icon in the main list of programs, depending on the 

operating system: In either case, click on the shortcut, and the program will start. 

 

Figure 3-8.  Click on the COMFEN 3.1 shortcut icon to start the program.  
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COMFEN will open to the following view and you can begin using the program by selecting either a recent 

Project to open or creating a New Project. 

 

Figure 3-9.  The first screen when COMFEN starts  
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3.4.  Uninstalling COMFEN 

If you need to uninstall COMFEN, follow the steps below. 

1. Go to the Control Panel and go to the Programs or Add/Remove Programs (depending on the 

operating system) choice. Highlight the previous version of COMFEN and select uninstall or remove 

(depending on the operating system). 

 

Figure 3-10. Go to Control Panel and click on Programs or Add/Remove Programs. 

2. The program will ask if you want to completely remove the application. Click OK to uninstall the 

program, or Cancel to cancel the uninstall process. 

 

Figure 3-11. Click OK to continue with the uninstall process. 
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3. While the program is being uninstalled, the Setup Status screen will appear. 

4. When the uninstall process is complete, the Maintenance Complete screen appears. Click Finish to 

complete the uninstall. 

 

Figure 3-12. Click Finish to complete the uninstall process. 
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3.5.  Troubleshooting 

When you first run the program after installing it, the results may show as zeros after the first calculation. If 

you have this problem, close the program, run it again, and the problem should go away. 

Please send E-mail to COMFENhelp@lbl.gov if you have any trouble running the program. 

mailto:RESFENhelp@lbl.gov
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4.  PROGRAM DESCRIPTION 

4.1.  Overview 

COMFEN, short for commercial fenestration, is a simple single-zone facade analysis tool based on 

EnergyPlus, a powerful building simulation engine. COMFEN can be used to evaluate a range of facade 

configurations in order to understand the impact of different design variables on facade performance. After 

defining a building type, location and zone properties (dimensions and loads from equipment and people 

and fenestration layout), several additional scenarios can be quickly created and compared side-by-side. 

Orientation, window-to-wall ratio (WWR), glazing type and/or shading can easily be varied in order to assess 

their impact on energy use, peak loads, daylighting and thermal and visual comfort.  

COMFEN includes a number of libraries with predefined facade components, including glazing, shading, 

material, wall and spandrel libraries. In addition to fixed exterior fins and overhangs, automated interior or 

exterior venetian blinds and roller shades can be evaluated using one of a number of predefined shading 

control options. . The shading system library, developed based on performance data for commercially-

available products, incorporates venetian blinds, roller shades, metal mesh screens and glazing-integrated 

venetian blinds. 

When COMFEN starts, the program prompts the user to select an existing project, or create a new project, 

window, glazing, or shading system. Double-clicking on one of the existing projects opens the project screen. 

 

Figure 4-1.   Opening Screen 
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Figure 4-2. The COMFEN Project Comparison Summary screen 

The primary steps to completing a COMFEN calculation are: 

 Defining the “scenarios” (alternative facade configurations for comparison)  

 Calculating the scenarios. This is done by highlighting one or more of the scenarios in the list on the 

left of the screen and clicking the lightning bolt icon . Alternatively, scenarios can be calculated 
by clicking the right mouse button and choosing Calculate performance. The program will calculate 
the heating, cooling, lighting, and fan energy use for each scenario, peak energy consumption, CO2 
emissions, annual daylight levels, and visual and thermal comfort. 

 Comparing scenarios of interest. Upon the completion of the calculations, the user can compare 
select scenarios side-by-side by navigating to the Comparison tab and then dragging select scenarios 
from the scenario list on the left of the screen to the blank area under the Comparison tab.  

This chapter describes the program in detail. 
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4.2.  Menu 

The COMFEN menu options are: 

COMFEN The COMFEN menu can be used to view the program version number and modify 
general program options. 

Project The Project menu is used to control projects  

Scenarios The Scenarios menu is used to control Scenarios within projects. 

Libraries The Libraries menu is used to access all of the libraries 

Help The Help menu provides links to the COMFEN website, websites discussing various 
aspects of facade design, and an online glossary  

  

COMFEN 

About COMFEN Lists program version number and program contributors 

Preferences Opens the Application Settings dialog box, which has four tabs: 

 Basic Settings:  Allows the user to turn on or off verbose logging. 

     

Figure 4-3.   Preferences / Basic Settings 

 Database:  This sets the database that COMFEN opens when the program is started. 
The default database that comes with the program is comfen.sqlite. However, by 
copying and renaming the default database the user can easily create multiple 
databases as needed. Once a new database is created, the user can locate the new 
database by clicking the browse button and navigating to the correct file.   

    

Figure 4-4.   Preferences / Database  

 EnergyPlus: This tab controls some basic settings for the Energy Plus simulation 
program, the underlying calculation engine for COMFEN:  
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- The Site-to-source multiplier determines whether energy use results are displayed 
in terms of site or source energy. Site energy is energy used by the building on 
site (as measured at the meter), while source energy is a measure that accounts 
for energy consumed on site as well as the energy consumed during the storage, 
transport and delivery of the fuel to the building.  Source energy is a better 
indicator of building environmental performance impact. By default, the 
multiplier is set to 1; electricity use results are displayed in terms of site energy.  

- If the Calculate illuminance box is checked, COMFEN calculates hourly 
horizontal illuminances throughout the space for a specific date and time. The 
results are displayed under the Comparison > Overview results tab in the form 
of color illuminance maps.  

- When the When calculating peak electricity usage... checkbox is checked, electrical 
energy used by equipment is included in the peak electricity use results for the 
zone. Regardless of whether this checkbox is selected, COMFEN uses the 
equipment load inputs to account for the heat generated by the equipment and 
its impact on heating and cooling loads. By default, electricity used by 
equipment is not included in the results. 

- When “Show EnergyPlus error log” or “Show in.imf file” are selected, these two 
files open automatically if EnergyPlus crashes.   

 

    

Figure 4-5.   Preferences / EnergyPlus 

 WINDOW 6:  This tab specifies the WINDOW 6 database from which additional 
glazing systems will be imported into COMFEN. 
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Figure 4-6.   Preferences / WINDOW6 

Hide COMFEN Minimizes the COMFEN window 

Quit Closes COMFEN 

  

Project 

New project Opens the Create COMFEN project dialog box where new project properties can be 
entered (project name, description, building type, project North, location, etc.). See the 
next section for more detailed information on creating projects. 

Open project Opens the Open COMFEN Project dialog box, which shows all of the projects currently 
defined in the currently open database. Projects can be opened by double-clicking or 
highlighting a project and then selecting Open. 

  
Figure 4-7.   Project / Open Project  

 

Close project Closes the currently open project, and returns to the startup menu screen. 

Project  
Properties Opens the Edit COMFEN project dialog box, which shows the details of the currently 

open project. The project properties can be changed here as needed and are discussed in 
more detail in the next section. 
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Figure 4-8.   Project / Project Properties  

Delete projects Opens the Delete COMFEN project dialog box, which shows the list of projects in the 
currently open database. Highlight a project, and click the Delete Selected to delete the 
entire project from the database. 

 

Figure 4-9.   Project / Delete Projects 

Import project  

definition from  

CSV file  Allows the user to import project and scenario information using previously created 
tabulated inputs in csv format. This option is especially useful for projects with multiple 
scenarios. All projects must be closed in order to import a csv file (the option is grayed 
out if a project is open). 

Export project 
results to CSV  Option that allows the export of COMFEN project results (annual and peak energy by 

end use, average illuminance levels, visual and thermal comfort, etc.) and basic scenario 
properties (orientation, WWR, glazing, shading system, lighting control setting, etc.) to a 
CSV file. 
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Scenarios 

Create Scenario Opens the Create New Scenario dialog box. 

 

Copy Scenario Creates a copy of highlighted scenario. 

Import Scenario 

from Project Allows the user to import a select scenario from another project. 

Delete Scenario Deletes highlighted scenario. 

Rename Scenario Renames highlighted scenario. 

Add Window  

to Scenario Adds a window to scenario. Unless scenario is active, this option is grayed out.     

Add  Exterior  

Shade to Scenario Adds fixed exterior projection (overhangs, fins, etc.) to scenario. Unless scenario is 
active, this option is grayed out.     

Export scenario 

output data to CSV Exports basic scenario information (orientation, glazing name, lighting control type, 
glazing type, etc.) and annual performance data (energy use by end use, peak energy use 
by end use, CO2 emissions, etc.) for all scenarios in open project. 

Export compared  

scenarios images   

to PNG Exports thumbnail images of select scenarios in *.png format. 

Calculate All Calculates performance of all scenarios in project 

Calculate Selected Calculates performance of highlighted scenarios.  To select multiple scenarios in explorer 
hold shift or ctrl key down while making selections with the left mouse button. 

 

Libraries 

The library menu allows the user to access all system and component libraries: 
 Windows 

 Glazing systems 

 Shading systems 

 Frames 

 Glass 

 Gas  

 Walls 

 Spandrels 

 Materials  

 Locations 

Import glazing system 

From WINDOW 6  Allows the user to import a glazing system from a WINDOW 6 database.  

Import IGDB data… Allows the user to update the glass library using a COMFEN *.sqlite database file. See 
section on glass library for more information on the IGDB database. 
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4.3.  Project  

To create a new project, select New Project from the Project menu. The Create COMFEN Project dialog box 

includes the following inputs: 

 

Figure 4-10.   Project Properties from New Project menu  

 Project Name: Field used to provide a unique name for the project.  

 Building Type: The following building/space type options are available: 

 Office (office space) 
 Mid-rise residential (apartment)  
 Hotel (guest room) 
 Retail (point of sale) 
 School (classroom) 

A more detailed description of the different building types and schedule assumptions is provided 
in the Calculation assumptions section.   

 Project North: Defines the overall project orientation, measured clockwise from true North. A 
project with a Project North of 0° faces true North. The value specified for Project North is added 
to the scenario orientation definition (North, South, East or West) to calculate the “resolved” 
orientation. For example, a scenario facing South with a Project North of 45° will in effect face 
southwest (45° degrees west of South) and its “resolved” orientation will be 45° + 180° = 225.° 
Default: 0 (project faces true north); Legal values: 0-359; Units: degrees.  
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Figure 4-11.  Illustration of project North axis. 

 

 Location:  This drop-down will determine the weather data that will be used for the simulation. 

 Default wall:  This is the default exterior wall construction assigned to the project based on the 
project's location. When the user specifies the project location, an ASHRAE-90.1-compliant wall is 
automatically assigned as the default wall for the project. See components and libraries section for 
information on creating and assigning custom walls. 

 Wall R-value:  This is the R-value corresponding for the default exterior wall.  

 HVAC system:  The default HVAC system is presently a packaged single zone system for all 
building types.  

 Calculation period:  By default, the simulation runs for the entire year, January 1 through 
December 31. 

 

 

   

 

 

 

project North axis (here 
project is rotated 30° 
clockwise from true North) 

true 

North  

30°  

COMFEN 

zone 
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4.4.  Scenario  

To create a new scenario, select Create Scenario from the Scenarios menu. This opens the Create New 

Scenario dialog box, shown in the image below, where new scenario information can be entered, including 

space dimensions, orientation and load information. The scenario orientation can be specified at one of the 

four cardinal directions (North, South, East, West). If the facade is not facing these cardinal orientations, this 

can be accounted for by entering a value in the Project North box in the Project Properties dialog box. 

   

Figure 4-12.   Create New Scenario 

After creating the enclosure for the scenario and inputting load information through the Create New Scenario 
dialog box, scenario inputs can be further edited in the scenario edit screen shown on the next page. The edit 
screen can be accessed by 1) double-clicking on the scenario under the scenario tab on the left side of the 
screen or 2) double-clicking on the image of the scenario in the Comparison tab.   

The scenario edit screen consists of the following tabs: 

 Scenario tab: tab where general scenario parameters, including geometry, orientation, loads and 
lighting controls are defined. The lighting control pulldown contains three choices for lighting 
and daylighting controls: none, continuous and stepped. See 4.7.2.   for a more detailed 
description of these options. 

Windows: Tab where window configuration is defined. Windows are added by clicking on the 

green “+” icon  in the upper-right hand corner of the tab, which brings up the New Dialog 

box. The new window inputs include window dimensions and position, glazing system, shading 

system (all systems except for fixed exterior projections) and frame type. Double-clicking on any 

entry in the table list view will bring up the edit window dialog box. Windows are deleted by 

highlighting the window and clicking the red “-“ icon . 

 NOTE: The glare control checkbox will turn on the glare control option, meaning that a shading 
system will be activated (deployed) when the glare index setpoint is reached. The glare index 
setpoint is 22 and this value cannot be changed by the user. 

 Additional shading control options can be specified under the shading system properties.  
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 Wall Shades:  Tab where fixed exterior projections such as horizontal overhangs and vertical fins 

are defined. Similar to window definition, wall shades are added by clicking on the green “+” 

icon  in the upper-right hand corner of the tab, which brings up the new wall shade definitions 

screen. Wall shades are deleted by highlighting the shade and clicking the red “-“ icon .  

Scenario tab: tab where general scenario parameters, including geometry, orientation, loads and 

lighting controls are defined. The lighting control pulldown contains three choices for lighting 

and daylighting controls: none, continuous and stepped. See 4.7.2.   for a more detailed 

description of these options. 

 

 
Figure 4-13.  Scenario tab. 
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4.5.  Facade components and libraries 

This chapter discusses construction components and COMFEN libraries in more detail. The libraries contain a 

range of predefined facade components such as windows, glazing systems, shading systems and frames as 

well as locations. They also include a comprehensive list of glass products from a range of manufacturers. 

New entries can be created in all libraries except for the glass and gas libraries. 

4.5.1.  Glazed wall assembly  

In addition to the option of creating individuals windows, i.e. punched windows within a scenario, the user 
can create a series of windows that fill up a part of or the whole facade by using the glazed wall assembly 
option. This feature is particularly useful for modeling storefronts and curtain wall assemblies as it makes it 
possible to create these quickly and easily.  

Creating a glazed wall assembly 

To create a glazed wall assembly, open the New glazed wall assembly dialog box by clicking on the "add 
glazed wall assembly icon" in the toolbar: 

Figure 4-14.   Toolbar with Glazed Wall Assembly icon 

This will pull up the glazed wall assembly dialog box: 

 

Figure 4-15  New glazed wall assembly dialog 

Add glazed wall assembly icon 
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NOTE: Only one glazing assembly can be created within a scenario and a scenario with a glazed wall 
assembly cannot have a punched window, or vice versa. 

 
The inputs for this dialog box are explained below: 

 Default frame:  This is the frame that will be used for the glazed wall assembly. Only one type of 
frame can be specified. 

 Assembly Height:  Height of the glazed wall assembly, measured from the bottom edge of the 
first framing member to the top edge of the last member. 

 Assembly Width:  Width of the glazed wall assembly, measured from the outside of the first 
framing member to the outside of the last member. 

 Count:  Number of horizontal or vertical framing elements. Minimum number of horizontal or 
vertical framing elements is 2. 

 Offset from bottom:  Position of the bottom edge of glazed wall assembly relative to the bottom 
edge of the scenario. 

 Offset from left:  Position of the left edge of glazed wall assembly relative to the left edge of the 
scenario. 

The table below the inputs lists each framing element (horizontal elements on the left and vertical on the 
right), along with its width, spacing and distance: 

 Width:  Width of framing element, equal to the width of the framing defined under the default 
frame input above. 

NOTE: Since it is assumed that the glazed wall assembly represents a "slice" through a glazed wall, 
perimeter framing elements are automatically modeled at 1/2 of the width of the framing member selected as 
the default frame.   

 Spacing - framing spacing, measured from center line to center line of framing member. The 
spacing of the first framing member is always 0. 

 Distance - distance of framing from edge of scenario elevation (either left or bottom edge) and the 
center line of framing member. 

 

After defining the type and position of the framing, the user specifies the default glazing and shading for 
the assembly (individual glazing units can be later edited interactively in the scenario elevation view).  

        

Figure 4-16.   Select the Glazed Wall Assembly Default Shading System and Glazing System 

When the glazed wall assembly framing and glazing is defined, click Done to save changes and exit.  



4.  PROGRAM DESCRIPTION 

4-14 DRAFT – AUGUST 2011 COMFEN 4.0 

 

Figure 4-17  Framing member spacing and distance 

 

Editing a glazed wall assembly 

Individual lites can be edited in the interactive scenario view if needed by left-clicking on a lite to highlight 
the lite and then right-clicking within the highlighted area to bring up the edit glazed wall assembly menu:  

 

Figure 4-18  Glazed wall assembly menu 

From this menu, the user can opt to edit a glazing system, assign or delete a shading system or specify a 
spandrel. "Edit glazed wall assembly" will bring up the New glazed wall assembly dialog box. 

 

NOTE: Any changes (e.g. glazing, shading an spandrel definitions) made in the interactive scenario view 
will be overwritten if changes are made under the New glazed wall assembly dialog box.  

 

To select multiple lites, hold the shift key while drawing a window starting with the window's upper left 
corner. Any lites that overlap with the drawn window will be highlithed. At this point, if you right-click, 
the menu with the options listed above will appear.  
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Figure 4-19  Multiple glazing unit selection 

 

                
 

TIP: To display the glazing, shading system and spandrel info markers, click on the information icon in the 
toolbar.  

 

General glazed wall assembly properties are summarized under the glazed wall tab. This is also where the 
user can select edit button to return to the glazed wall assembly dialog box.  

 

 

Figure 4-20  Glazed wall tab 

Information icon 
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4.5.1.  Glass layers 

The glass library contains entries from the International Glazing Database (IGDB) – a database containing 

measured performance data for commercially-available products that is submitted by manufacturers to 

LBNL, where they undergo technical and a peer review. While the latest version of the IGDB database is 

automatically installed with COMFEN, it is updated bimonthly by LBNL in an effort to ensure that it contains 

all of the latest commercially-available products. COMFEN users are encouraged to periodically update their 

libraries by downloading a COMFEN *.sqlite update file from the COMFEN online Knowledge Base. 

Below is a description of select fields in the glass library: 

NFRC ID The ID field in the glazing system edit view refers to the glass or gas layers, and displays 
the NFRC identification number from the IGDB used in WINDOW 6 software. This field 
cannot be edited by the user. 

Name The IGDB filename for the glass layer or the name of the gas layer. These names come 
from the respective glass and gas selection lists, and cannot be edited by the user. 

Thickness The thickness of the glass or gas layer. The glass layer thickness values cannot be edited, 
but the gap (gas) layer thicknesses can be edited by the user. Units: mm 

Source Lists the IGDB version.  

Emis1 Emissivity of the front surface of the glass layer. This value is 0.84 for uncoated glass. 
The emissivity values for front and back can be used to determine if a layer should be 
“flipped” so that the coating is on the correct surface.  This field cannot be edited by the 
user. 

Emis2 Emissivity of the back surface of the glass layer. See comment for front emissivity above. 

 

Figure 4-21.  Definition of front and back glass layer surfaces 

4.5.2.  Gas layers 

The entries in the COMFEN gas library come from a database that is installed with COMFEN, which contains 

the standard gases defined in the LBNL WINDOW software programs. The figure below shows the current 

gases available for glazing systems in COMFEN. The gas layers are used in the creation of COMFEN glazing 

systems. 
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Figure 4-22.  COMFEN gas library 

 

4.5.3.  Glazing systems 

 

Glazing system library 

The glazing system library is accessed by selecting “View all glazing systems” from the Libraries menu. There 

are approximately 50 predefined glazing systems in the Glazing System Library, which includes both several 

generic glazing systems (ID# 1-15) as well as a limited selection of commercially available insulated glazing 

products (ID# 100 and beyond). A glazing system can consist of a single glass layer (e.g. similar to the first 

entry in the image below), or of two or more glass layers separated by a gas layer. Any glazing systems 

defined in the glazing system library can be assigned to a window, whether it is a window in the window 

library or a window in the scenario edit screen.  New glazing systems can be added to this library as needed, 

by either creating the assembly directly in COMFEN or importing a glazing system from the WINDOW 6 

glazing system library. 

 

Figure 4-23.   Glazing system library 
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The ID of the glazing system is automatically generated in sequence by COMFEN. When glazing systems are 

imported into COMFEN, the ID from WINDOW will not be kept, but a new ID will be assigned based on the 

records already in this Glazing System Library. 

The user can specify a unique glazing system name under the name field. Existing entries based on 

commercially available products follow the following naming format: 

 Uncoated double glazing:  

<Manufacturer> -- <substrate #1> <substrate #2> <gap fill> 

 Double insulated glazing with a low-e or solar control coating: 

<Manufacturer> -- <coating name> <coating surface no.> <substrate #1> <substrate #2> <gap fill>  

 Triple insulated glazing with a low-e or solar control coating: 

<Manufacturer> -- <coating name> <coating surface no.> <substrate #1> <substrate #2> <substrate #3> <gap fill>  

 

Creating a new glazing system 

To create a new glazing system, select the new button in the lower right-hand corner of the glazing system 

library. Under the Create New Glazing System screen (see image below), drag glass and gas layers from the 

right-hand list view to create desired assembly.  

 

Figure 4-24.  Glazing system creation screen 
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Layer no. 

field The layer no. field (far left column in the image below) identifies the layer sequence 
number in the glazing system. The first layer is the layer on the outside (exterior) of the 
glazing system, the last layer is the layer on the inside (interior) of the glazing system. 
Gas spaces are also counted as layers. The outside and inside layers have to be a glass 
layers, and each glass layer has to be separated by a gas fill.  

 

  

 

Figure 4-25.  Glass and gas layers are numbered from outside to inside 

 

The Calculate using WINDOW 6 button calculates the thermal and optical properties for the glazing system 

(Tvis, SHGC, U-factor and thickness) using WINDOW 6 calculation algorithms. If the glazing system is 

imported from WINDOW 6, these values will usually already be calculated and will appear in this section.  

 

Figure 4-26.  The Results section of the Glazing System Library 

 

Tvis   Visible transmission of the complete glazing system 

SHGC   Solar Heat Gain Coefficient for the whole glazing system 

U-factor  U-factor for the complete glazing system, in Btu/h-ft-F (IP units) or W-m2-K (SI units) 

Thickness  Thickness of the complete glazing system in in. (IP units) or mm (SI units) 

 

Outside  
(Exterior) 

Inside  
(Interior) 
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Importing a glazing system from WINDOW 6 

To import a glazing system from WINDOW 6, navigate to the main glazing system library tab (Libraries > 

glazing systems) and click on the Import from WINDOW6 button at the bottom of the screen.  

 

Figure 4-27.   Import from WINDOW6 Glazing System Option 

Or go to Libraries > Import glazing system from WINDOW 6. 

This will bring up a list of glazing systems in the WINDOW 6 database. Navigate to the desired system and 

click Import. 

NOTE: COMFEN cannot import WINDOW 6 glazing systems that have shading systems associated with them. 

 

Figure 4-28.  WINDOW 6 glazing system import screen 
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NOTE: The WINDOW 6 library from which glazing systems will be imported is specified through Preferences under the 
COMFEN menu. If you want to change the database, click on the Browse button and navigate to the desired WINDOW 
6 database. 

  

 Figure 4-29.  Select a WINDOW 6 database from which to import glazing systems 

  

4.5.4.  Shading systems 

The shading system library is used to model venetian blinds, shades (cloth blinds, roller shades, drapes, etc.) 

and fixed exterior screen shading systems. The types of shading systems that can currently be modeled in 

COMFEN are based on the modeling capabilities of the EnergyPlus simulation engine used by COMFEN. 

Venetian blinds and roller shades can be controlled automatically using one of the control options in 

COMFEN. The list of systems and available modeling options are summarized in more detail in the sections 

below. 

Venetian blinds 

COMFEN allows modeling of interior, exterior and in-between-glass venetian blinds, which can be defined 

under the shading system properties screen (see image below). All of these systems can be modeled as fixed 

or automated using one of COMFEN’s predefined shading control algorithms. To access the shading system 

properties screen, double-click on any shading system under the shading system library tab, or select “New” 

to create a new system. 
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Figure 4-30.  Venetian blinds can be defined in three  
different locations relative to the glazing system. 

 

Figure 4-31.  Shading system properties screen.  

 

Slat Orientation Orientation of the venetian blind, either: 

 Horizontal - slat is parallel to window sill 

 Vertical - slat is perpendicular to window sill 

Slat geometry 

Slat width The width of the slat. Units: inches (IP), mm (SI) 

Slat Spacing The spacing between slats. Units: inches (IP), mm (SI) 

Slat Tilt The rotation of the slat, measured clockwise from the glazing outward normal to the slat 
outward normal.  Units: degrees 
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Figure 4-32.  Slat angle definition  

(Source: EnergyPlus Input Output Reference)  

 

Slat Thickness The thickness of the slat. Units: inches (IP), mm (SI) 

Slat Conductivity The conductivity of the slat material. Units: Btu/h-ft-oF (IP), W/m-K (SI) 

Min Slat Tilt The minimum slat tilt, used for the “Block Beam Solar” control. Units: degrees 

Max Slat Tilt The maximum slat tilt, used for the “Block Beam Solar” control. Units: degrees. 

NOTE: COMFEN will not run if slats overlap, so when slat spacing is less than the slat width, make sure that the 
minimum and maximum slat angles account for the fact that slat angle will be greater than 0 (or smaller than 180) 
when blinds are completely closed.  

NOTE: Inbetween venetian blinds can only be simulated in double and triple glazing systems. 

 

Slat Optical Properties 

Transmittance, 
Beam Solar Slat transmittance for direct beam solar radiation. 

Transmittance, 
Diffuse Solar Slat transmittance for diffuse solar radiation. 

Transmittance, 
Beam Visible Slat transmittance for direct beam visible radiation. 

Transmittance, 
Diffuse Visible Slat transmittance for diffuse visible radiation. 

Reflectance, front 
Beam Solar Reflectance on the front surface of the slat for direct beam solar radiation. 

Reflectance, front 
Diffuse Solar Reflectance on the front surface of the slat for diffuse solar radiation. 

Reflectance, front  
Beam Visible Reflectance on the front surface of the slat for direct beam visible radiation. 

Reflectance, front 
Diffuse Visible Reflectance on the front surface of the slat for diffuse visible radiation. 

Reflectance, back 
Beam Solar Reflectance on the back surface of the slat for direct beam solar radiation. 

Reflectance, back 

Front surface 

Back surface 
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Diffuse Solar Reflectance on the back surface of the slat for diffuse solar radiation. 

Reflectance, back 
Beam Visible Reflectance on the back surface of the slat for direct beam visible radiation. 

Reflectance, back 
Diffuse Visible Reflectance on the back surface of the slat for diffuse visible radiation. 
 

Slat IR thermal hemispheric properties 

Transmittance Slat transmittance for infrared radiation 

Emissivity, Front Emissivity of the front surface of the slat. Default value: 0.9 

Emissivity, Back Emissivity of the back surface of the slat. Default value: 0.9 

 

Shading control 

The following control options are presently available in COMFEN, some of which are limited to specific 

shading systems. The default shading system setpoints are listed in Table 4-3. 

NOTE: Timestep is equal to 15 minutes. 

 Always on: Shading is always lowered/deployed 

 Always off: Shading is always raised/retracted 

 On If Schedule Allows: This control cannot be used in COMFEN because it does not allow 
scheduling of controls 

 On If High Solar On Window: Shading is lowered/deployed if beam solar radiation plus 
diffuse solar radiation incident on the window exceeds the setpoint (W/m2). The setpoint value 
is specified in the control setpoint 1 field. 

 On If High Horizontal Solar:  Shading is lowered/deployed if total (beam plus diffuse) 
horizontal solar irradiance exceeds setpoint (W/ m2). The setpoint value is specified in the 
control setpoint 1 field. 

 On If High Outdoor Air Temp: Shading is lowered/deployed if outside air temperature 
exceeds setpoint (°C). The setpoint value is specified in the Control setpoint 1 field. 

 On If High Zone Air Temp: Shading is lowered/deployed if the room air temperature in the 
previous timestep exceeds setpoint (°C). The setpoint value is specified in the control setpoint 1 
field. 

 On If High Zone Cooling: Shading is lowered/deployed if the room cooling rate in the 
previous timestep exceeds setpoint (W). The setpoint value is specified in the control setpoint 1 
field. 

 On If High Glare: Shading is lowered/deployed if the daylight glare index (DGI) at the room’s 
first daylighting reference point (sensor #1) exceeds the maximum glare index (22). The 
calculation is performed assuming that the occupant is positioned at the first daylighting 
reference point is at desk level - 2'-6" (0.76 m) above floor level.  

The glare view azimuth (i.e. rotation of the sensor) determines the rotation of the occupant from 
the facade. By default, the azimuth (measured clockwise from an axis normal to the facade) is 
set to 90°, i.e. the sensor is rotated 90° clockwise from the facade so that it faces one of the zone 
side walls. For a south-facing zone and a glare view azimuth angle of 90° the occupant faces 
west, while for a west-facing scenario and a glare view azimuth angle of 90° the occupant faces 
north, and so on. The glare view azimuth is equal to 90° regardless of orientation. 
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Presently the user cannot change the occupant’s position or glare view azimuth angle through 
the COMFEN interface. They can, however, change the glare view azimuth angle by accessing 
the comfen_settings.xml file in the settings folder.  
 
NOTE: COMFEN must be closed when editing the glare view azimuth angle in the comfen_settings.xml 
file in order for the change to take effect.  

 On Night If Low Outdoor Temp / Off Day: Shading is lowered/deployed at night if the 
outside air temperature is less than the setpoint (°C). Shading is raised/retracted throughout 
the day. The setpoint value is specified in the control setpoint 1 field. 

 On Night If Low Inside Temp / Off Day: Shading is lowered/deployed at night if the room air 
temperature in the previous timestep is less than the setpoint (°C). Shading is raised/retracted 
throughout the day. The setpoint value is specified in the control setpoint 1 field. 

 On Night If Heating / Off Day: Shading is lowered/deployed at night if the zone heating rate 
in the previous timestep exceeds the setpoint (W). Shading is raised/retracted throughout the 
day. The setpoint value is specified in the control setpoint 1 field. 

 On Night If Low Outside Temp  / On Day If Cooling: Shading is lowered/deployed at night if 
the outside air temperature is less than setpoint (°C). During the day, shading is 
raised/retracted if the zone cooling rate in the previous timestep is non-zero. The setpoint 
value is specified in the control setpoint 1 field. 

 On Night If Heating / On Day If Cooling: Shading is lowered/deployed at night if the zone 
heating rate in the previous timestep exceeds setpoint (W). During the day, shading is 
raised/retracted if the zone cooling rate in the previous timestep is non-zero. The Setpoint 
value is specified in the control setpoint 1 field. 

 Off Night  / On Day If Cooling And High Solar On Window: Shading is raised/retracted at 
night. Shading is lowered/deployed during the day if the solar radiation incident on the 
window exceeds setpoint (W/ m2) and if the zone cooling rate in the previous timestep is non-
zero. The setpoint value is specified in the control setpoint 1 field. 

 On Night / On Day If Cooling And High Solar On Window: Shading is lowered/deployed 
throughout the night. During the day, shading is lowered/deployed if the solar radiation 
incident on the window exceeds setpoint (W/ m2) and if the zone cooling rate in the previous 
timestep is non-zero. The setpoint value is specified in the control setpoint 1 field. 

 On If High Outside Air Temp And High Solar On Window: Shading is lowered/deployed if 
the outside air temperature exceeds Setpoint 1 (°C) and if the solar radiation incident on the 
window exceeds setpoint 2 (W/ m2). The setpoint values are specified in the control setpoint 1 
and Control setpoint 2 fields. 

 On If High Outside Air Temp And High Horizontal Solar: Shading is lowered/deployed if 
the outside air temperature exceeds the setpoint (°C) and if the horizontal solar radiation on the 
window exceeds setpoint 2 (W/m2). The setpoint values are specified in the control setpoint 1 
and control setpoint 2 fields. 

Control  
Setpoint 1 For controls that require one setpoint, enter it here. See the control list above. 

Control  
Setpoint 2 For controls that require two setpoints, enter the second one here. See the control list 

above. 

Slat Angle for 
Control for 
Venetian Blinds The following slat control options are available for venetian blinds: 
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 Fixed slat angle:  Slat angle is fixed at the angle defined under the slat tilt input 
field. 

 Block beam solar:  Slat angle is adjusted at every simulation timestep (15 minutes) 
in order to block direct solar radiation from coming into the room. The minimum 
slat tilt (min. tilt) and maximum slat tilt (max. tilt) entries under the "Details" section 
of the shading properties dialog box define the range of slat rotation.  

The list of available shading control types in COMFEN is based on the modeling features of Energy Plus. The 

Energy Plus Input/Output Reference documentation (found on their website at 

http://apps1.eere.energy.gov/buildings/energyplus/energyplus_documentation.cfm) contains detailed 

information about each control.  
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Table 4-1. Shading System Controls Strategies 

 

Shading Control 
Setpoint 1 

default value 

Setpoint 1 

Units 

Setpoint 1 

default value 
Setpoint 2 

Units 

AlwaysOn N/A N/A N/A N/A 

AlwaysOff N/A N/A N/A N/A 

OnIfScheduleAllows N/A N/A N/A N/A 

OnIfHighSolarOnWindow 
0 
0 

W/m
2 

  (SI) 
Btu/h-ft

2
 (IP) 

N/A N/A 

OnIfHighHorizontalSolar 
0 
0 

W/m
2 

  (SI) 
Btu/h-ft

2
 (IP) 

N/A N/A 

OnIfHighOutdoorAirTemperature 
0 
0 

°C  (SI) 
°F  (IP) 

N/A N/A 

OnIfHighZoneAirTemperature 
0 
0 

°C  (SI) 
°F  (IP) 

N/A N/A 

OnIfHighZoneCooling 
0 
0 

Watts  (SI) 
BTU/hr  (IP) 

N/A N/A 

OnIfHighGlare
*
 N/A N/A N/A N/A 

OnNightIfLowOutdoorTempAndOffDay 
0 
0 

°C  (SI) 
°F  (IP) 

N/A N/A 

OnNightIfLowInsideTempAndOffDay 
0 
0 

°C  (SI) 
°F  (IP) 

N/A N/A 

OnNightIfHeatingAndOffDay 
0 
0 

Watts  (SI) 
BTU/hr  (IP) 

N/A N/A 

OnNightIfLowOutdoorTempAndOnDayIfCooling 
0 
0 

°C  (SI) 
°F  (IP) 

N/A N/A 

OnNightIfHeatingAndOnDayIfCooling 
0 
0 

Watts  (SI) 
BTU/hr  (IP) 

N/A N/A 

OffNightAndOnDayIfCoolingAndHighSolarOnWindow 
0 
0 

W/m
2 

  (SI) 
Btu/h-ft

2
 (IP) 

N/A N/A 

OnNightAndOnDayIfCoolingAndHighSolarOnWindow 
0 
0 

W/m
2 

  (SI) 
Btu/h-ft

2
 (IP) 

N/A N/A 

OnIfHighOutdoorAirTempAndHighSolarOnWindow 
0 
0 

°C  (SI) 
°F  (IP) 

0 
0 

W/m
2 

  (SI) 
Btu/h-ft

2
 (IP) 

OnIfHighOutdoorAirTempAndHighHorizontalSolar 
0 
0 

°C  (SI) 
°F  (IP) 

0 
0 

W/m
2 

  (SI) 
Btu/h-ft

2
 (IP) 

OnIfHighZoneAirTempAndHighSolarOnWindow 
0 
0 

°C  (SI) 
°F  (IP) 

0 
0 

W/m
2 

  (SI) 
Btu/h-ft

2
 (IP) 

OnIfHighZoneAirTempAndHighHorizontalSolar 
0 
0 

°C  (SI) 
°F  (IP) 

0 
0 

W/m
2 

  (SI) 
Btu/h-ft

2
 (IP) 

 
* When this option is selected, no setpoint input is required; shading is automatically retracted when the Daylight Glare Index exceeds 
22. 
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4.5.5.  Materials 

The material library contains a range of predefined construction materials used for wall and spandrel 

assemblies. New materials can be easily added to the library. A number of properties need to be defined for a 

typical material in order to ensure that heat transfer through the material is modeled correctly by the program 

– see image of material properties dialog box.  

 

Figure 4-33.   Material library list view 

 

Material properties dialog box input fields: 

ID A unique material ID automatically generated when a material is created 

Name A unique material name assigned by user 

Group Primary material library subdivisions (e.g. masonry, boards and finishes, insulation, 
cladding, membranes, etc.)  

Subgroup Group subdivision 

Source Source from which material properties were obtained, e.g. ASHRAE Handbook of 
Fundamentals 

Type This field is used to characterize the material's thermophyscial properties, primarily its 
thermal storage capacity. The field also determines the required inputs for the material 
properties dialog box. COMFEN recognizes three different types of materials: 
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1. Default (with thermal capacity): A material with thermal storage capacity; this is 
the default material type for materials. This option should typically be selected as 
it will ensure that EnergyPlus will account for the thermal mass of the material 
and thus evaluate the effect of transient conduction. This material type requires 
that a range of thermophysical properties be specified.  

Required inputs:  Conductance, density, specific heat, emissivity, (front), 
emissivity (back), thickness, and optical properties: solar transmittance and 
reflectance (front and back), visible transmittance and reflectance (front and 
back), and IR transmittance. 

2. Lightweight (no thermal capacity):  Similar to a "Default (no thermal capacity)" 
material, however the material's thermal storage capacity is not taken into 
account. Option should only be used for materials with minimal thermal storage 
capacity (e.g. insulation).  

Required inputs:  Same as default material type, except density and specific heat 
are not required. Also, thermal resistance (R-value) is required in place of 
conductance. 

3. Air gap: This option is used to define an air gap between layers in a construction. 
Similar to a lightweight material, the thermal capacity of an air gap layer is 
negligible. However since the layer is not exposed to any external environment, 
surface properties such as absorptance and reflectance are not a required input.  

Required inputs: Thermal resistance (R-value) and thickness 

 

 

Figure 4-34.   Material properties dialog box 
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Energy Plus Documentation: Note that the corresponding Energy Plus material 
descriptors for the COMFEN material types listed are "Material," "Material:NoMass" 
and "Material:AirGap." For a more detailed description of the Energy Plus material 
types please refer to the "Group – Surface Construction Elements" chapter in the Energy 
Plus Input Output Reference. 

Roughness Field used to define material roughness, a property which influences convection 
coefficients used in the calculation of surface heat transfer. Inputs range from very rough 
to very smooth. Only default and lightweight materials require a roughness input. The 
following table lists roughness categories and provides examples of specific construction 
materials. 

 
Table 4-2. Example of different roughness materials 

 

Roughness index Example material 

Very rough Stucco 

Rough Brick, rough plaster, rough stone, unfinished terra cotta tile 

Medium rough Concrete 

Medium smooth Clear pine, wood siding 

Smooth Smooth plaster, smooth stone 

Very smooth Glass, painted pine, polished metal 

 

  Energy Plus Documentation: For a more detailed description of roughness and the 
calculation methodology for exterior convection coefficients please refer to the “Group – 
Simulation Parameters: SurfaceConvectionAlgorithm: Outside” and “Group - Surface 
Construction Elements: Material” chapters in the Energy Plus Input Output Reference and 
the “Outside Surface Heat Balance – Outdoor/Exterior Convection” chapter in the 
Energy Plus Engineering Reference. 

Comment Field for optional comments 

 

4.5.6.  Walls 

The scenario wall construction can be changed under the scenario tab, where any wall from the wall library 
can be selected from a drop-down menu. All of the walls listed under this drop-down can be edited and 
deleted under the wall library.  

 

Figure 4-35.   Scenario Wall Construction Reference 
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Wall library 

To access the wall library, go to the menu - Libraries > Walls. The first few walls in the library represent 
wood stud walls that comply with the requirements of ASHRAE Standard 90.1; these walls meet ASHRAE 
minimum wall R-value requirements for specific climate zones. The effect of thermal bridging at the wood 
studs within the cavity is already accounted for, i.e. frame spacing and width, requirements for cavity 
insulation and continuous insulation (c.i.) outboard of the cavity match ASHRAE prescriptive method 
requirements. When a user creates a new project, an ASHRAE-compliant wall is automatically assigned to 
the project as the default wall based on the project's location and climate zone.    

 

Figure 4-36.   Wall Construction Library List View 

Creating a new wall  

To add a new wall to the COMFEN library, go to Libraries > Walls to pull up the wall library, and then click 
"New." This pulls up the wall create/edit screen. The table on the left side of the screen shows the wall 
assembly. Wall layers are added by dragging entries from the material library on the right side of the 
screen. Layers in the wall construction table can be reordered by dragging the entries. The table columns are 
described below. 

 The first column represents the layer number. Layers are counted from the outermost 
(outside) layer to the innermost (inside) layer.  

ID Unique material ID# 

Material Material name 

Framing Indicates whether the layer is continuous or discontinuous. For the latter option, the 
layer is designated as either framing or cavity. This option is intended for modeling 
layers with thermal bridging such as wood stud walls with insulated cavities (COMFEN 
cannot presently model steel stud cavities). The user specifies % framing area below the 
table. COMFEN calculates the effective wall R-value using the isothermal planes method 
which accounts for the effect of thermal bridging through wood studs.      

Thickness  Thickness of the material layer 

R-value frame R-value of the layer designated as "framing"  

R-value cavity R-value of the layer designated as "cavity"  

 
Wall assembly characteristics 

% framing Width of framing/framing spacing * 100%. Range: 1 to 99% 
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U-factor Effective U-factor for whole wall (accounts for effect of framing and outside and inside 
film coefficients). 

R-value Effective R-value for whole wall (accounts for effect of framing and outside and inside 
film coefficients) 

Assembly thickness Effective wall thickness 

 

 

Figure 4-37.   Wall Construction Detail View 

NOTE:  While COMFEN can accurately model thermal bridging through wood stud cavities, it cannot 
presently calculate the resistance of a wall with highly conductive materials, such as metal studs. However 
sample steel stud walls have been provided in the wall library. 

NOTE:  When creating a wall, the following conditions must be met:  

1. The outermost and innermost layers of the construction must be air films (materials from the 
"film coefficient" group). 

2. A wall with a "composite" layer - a combination of two discontinuous materials such as wood 
studs (framing) with insulation in the cavity must have a continuous "enclosing" layer on 
either side of the composite: a "regular" or "lightweight" material type. The cavity and framing 
must be modeled as adjacent layers. 

3. If you define a material as a "cavity" in the wall construction table on the left-hand screen of the 
wall edit screen, you also have to define a "framing" material, and vice versa.  

4. Framing materials must come from the framing group in the material library and cavity 
materials must come from the air cavity or insulation group. 

5. Air spaces must be inbetween two other construction materials (i.e. material types "regular" 
and/or "lightweight"). Air spaces cannot be adjacent to one another. 
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Figure 4-38.   Creating a New Wall Construction 

 
Changing the default project wall 

The user can change the default project wall defined based on the project location (see Project > Project 
properties dialog box) at the level of the scenario or at the level of the project. To change the wall for the 
scenario, open the scenario and go to the scenario tab. Under the Geometry and materials section, click on 

the search icon  to bring up a list of walls in the library. Highlight wall of choice and click select to 
assign wall to scenario.  
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The default wall assigned to scenarios can be changed under the location tab. To do this, go to the location 
library (Libraries > Locations) and double-click on locations of choice (you may want to make a copy of the 
original location beforehand and open the copy rather than the original entry). Once open, select wall of 
choice under the default wall drop-down and save revised location. Any project created with this location 
will now have the new default wall automatically assigned to it.   

 

4.5.7.  Spandrels 

Spandrels can only be assigned to scenarios with a glazed wall assembly. To assign a spandrel to a glazed 
wall assembly, highlight one or more glazing units in the scenario view. Right-click within the highlighted 
area to bring up the glazed wall assembly menu and select "Set to spandrel." This will bring up a list of 
spandrels in the library. Select the spandrel of choice and click "Select." To edit the spandrel, select "Set to 
spandrel" in the glazed wall assembly menu to once again bring up the list of options.   

 

Figure 4-39.   Defining Spandrels 

Spandrel library 

To access the spandrel library, go to the menu - Libraries > Spandrels. The existing entries represent 
examples of typical spandrel construction. The user can add new spandrel constructions to the library as 
needed.  

 
Figure 4-40.   Material properties dialog box 
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Creating a new spandrel 

To add a new spandrel to the COMFEN library, go to Libraries > Spandrels to pull up the spandrel library, 
and then click "New." This pulls up the spandrel create/edit screen. Here, you can drag materials from the 
right-side of the screen to create a custom spandrel.  

NOTE:  When creating a spandrel, the following conditions must be met:  

1. The outermost and innermost layers of the construction must be air films (materials from the 
"film coefficient" group). 

2. Air spaces must be inbetween two other construction materials (i.e. material types "regular" 
and/or "lightweight"). There cannot be adjacent air spaces within the construction. 

3. Only glazing systems with up to three glass layers can be specified in a spandrel. 

4. Multiple glazing systems within a spandrel are not allowed; only one glazing system or glass 
layer can be used.  

 

 
Figure 4-41.   Spandrel Library Detailed View 
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4.5.8.  Locations 

 

Figure 4-42.   Location Library List View 

 

 

Figure 4-43.   Location Library Detailed View 
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4.6.  Results 

4.6.1.  Detailed reports 

The COMFEN results folder (LBNL\COMFEN4\Results) contains the following files: 

 scen_ID.idf 

 scen_ID_binned_eplus_output_data.csv 

 scen_ID_eplusmap.csv 

 scen_ID_eplusout.csv 

 scen_ID_eplusTbl_Table.csv 

The last two files contain additional results, including peak load and shade operation.  

An additional file, scen_ID_user_report.csv, will be generated if the user edits the user_report_variables.xml file 
in the LBNL\COMFEN4\settings folder and specifies additional variables for which they would like detailed 
results to be generated. By default, none of these variables are selected so no reports are generated. The user 
can specify reports they want generated by enclosing variables of interest with the following markers: 

<!--  denotes beginning of section 

--> denotes end of section 

In the following example, which shows only a few of the variables in the .xml file, hourly “Direct Solar”and 

"Solar Azimuth Angle" reports will be generated. 

<variable keyValue="*" nameInReport="Diffuse Solar" nameInRVI="Diffuse Solar" /> 

<!-- <variable keyValue="*" nameInReport="Direct Solar" nameInRVI="Direct Solar" /> 

<variable keyValue="*" nameInReport="Solar Azimuth Angle" nameInRVI="Solar Azimuth Angle" /> 

<variable keyValue="*" nameInReport="Solar Altitude Angle" nameInRVI="Solar Altitude Angle" /> --> 

<variable keyValue="*" nameInReport="Solar Hour Angle" nameInRVI="Solar Hour Angle" /> 

NOTE: It is a good idea to create a copy of this file prior to editing in order to keep the original with complete list of 

variables. A more advanced text editor (e.g. TextPad) is recommended for editing the file because lack of paragraph 

formatting in Notepad makes it difficult to view the list of report variables.  
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4.7.  Calculation assumptions 

General simulation parameters such as schedule, building type, etc. are written to the in.idf file located in the 
COMFEN Energy Plus Input folder. 

4.7.1.  Schedules and setpoints  

The following building types can be presently modeled in COMFEN. 

 Office (office space) 
 Mid-rise residential  
 Hotel (guest room) 
 Retail (point of sale) 
 School (classroom) 

This section includes heating and cooling setpoints and schedules (occupancy, lighting, electrical equipment 
and infiltration) by building/space type.  

Office (office space) 

Cooling and heating setpoints, °C                               

CLG-SCHED   
Temperature,              
  Through: 12/31,           
  For: Weekdays SummerDesignDay 
  Until: 06:00,             
  26.7,                     
  Until: 22:00,             
  24.0,                     
  Until: 24:00,             
  26.7,                     
  For: Saturday,            
  Until: 06:00,             
  26.7,                     
  Until: 18:00,             
  24.0,                     
  Until: 24:00,             
  26.7,                     
  For: AllOtherDays,        
  Until: 24:00,             
  26.7                     
 
HTG-SCHED,   
  Temperature,              
  Through: 12/31,           
  For: Weekdays,            
  Until: 06:00,             
  15.6,                     
  Until: 22:00,             
  21.0,                     
  Until: 24:00,             
  15.6,                     
  For: Saturday,            
  Until: 06:00,             
  15.6,                     
  Until: 18:00,             
  21.0,                     
  Until: 24:00,             
  15.6,                     
  For: WinterDesignDay,     
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  Until: 24:00,             
  21.0,                     
  For: AllOtherDays,        
  Until: 24:00,             
  15.6 

                    

Infiltration

Time

Infiltr. 

(week

day)

Infiltr. 

(Sat.)

Infiltr. 

(all 

other 

days)

24:00 – 

6:00
1 1 1

6:00 – 

18:00
0.25 0.25 1

18:00 – 

22:00
0.25 1 1

22:00 – 

24:00
1 1 1

 

Occupancy, Lighting and Equipment

Time

Occ. 

(week

day)

Occ. 

(Sat.)

Occ. 

(all 

other 

days)

Light. 

(week

day)

Light. 

(Sat.)

Light. 

(all 

other 

days)

Equip. 

(week

day)

Equip. 

(Sat.)

Equip. 

(all 

other 

days)

24:00 – 

5:00
0 0 0 0.05 0.05 0.05 0.4 0.3 0.3

5:00 – 

6:00
0 0 0 0.1 0.05 0.05 0.4 0.3 0.3

6:00 – 

7:00
0.1 0.1 0 0.1 0.01 0.05 0.4 0.4 0.3

7:00 – 

8:00
0.2 0.1 0 0.3 0.01 0.05 0.4 0.4 0.3

8:00 – 

12:00
0.95 0.5 0 0.9 0.5 0.05 0.9 0.5 0.3

12:00 – 

13:00
0.5 0.5 0 0.9 0.5 0.05 0.8 0.5 0.3

13:00 – 

14:00
0.95 0.5 0 0.9 0.5 0.05 0.9 0.5 0.3

14:00 – 

17:00
0.95 0.1 0 0.9 0.15 0.05 0.9 0.35 0.3

17:00 – 

18:00
0.7 0 0 0.7 0.05 0.05 0.8 0.3 0.3

18:00 – 

20:00
0.4 0 0 0.5 0.05 0.05 0.6 0.3 0.3

20:00 – 

22:00
0.1 0 0 0.3 0.05 0.05 0.5 0.3 0.3

22:00 – 

24:00
0.05 0 0 0.1 0.05 0.05 0.4 0.3 0.3
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Occ. Light. Equip. Infiltr. Occ. Light. Equip. Infiltr.

24:00 – 

6:00
0 1 1 1 0 0 0 1

6:00 – 

18:00
1 1 1 0.25 0 0 0 0.25

18:00 – 

22:00
1 1 1 0.25 0 0 0 1

22:00 – 

24:00
0.05 1 1 1 0 0 0 1

Winter design daySummer design day

Time

 

Mid-rise residential (apartment)  

Cooling and heating setpoints, °C 

CLG-SCHED  
 Temperature,              
  THROUGH: 12/31,           
  FOR:AllDays,              
  UNTIL: 24:00  
  23.9  
                      
HTG-SCHED,   
  Temperature,              
  THROUGH: 12/31,           
  FOR:AllDays,              
  UNTIL: 24:00,             
  21.1  
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Infiltration

All times 1.0

Occupancy, Lighting and Equipment

All days

Time Occ. Light. Equip. Time Occ. Light. Equip. 

24:00 – 

1:00
1.00 0.07 0.45

12:00 – 

13:00
0.25 0.12 0.69

1:00 – 

2:00
1.00 0.07 0.41

13:00 – 

14:00
0.25 0.12 0.66

2:00 – 

3:00
1.00 0.07 0.39

14:00 – 

15:00
0.25 0.12 0.65

3:00 – 

4:00
1.00 0.07 0.39

15:00 – 

16:00
0.25 0.21 0.68

4:00 – 

5:00
1.00 0.19 0.38

16:00 – 

17:00
0.30 0.44 0.80

5:00 – 

6:00
1.00 0.39 0.43

17:00 – 

18:00
0.52 0.62 1.00

6:00 – 

7:00
1.00 0.44 0.54

18:00 – 

19:00
0.87 0.83 1.00

7:00 – 

8:00
0.85 0.39 0.65

19:00 – 

20:00
0.87 0.99 0.93

8:00 – 

9:00
0.39 0.17 0.66

20:00 – 

21:00
0.87 1.00 0.89

9:00 – 

10:00
0.25 0.12 0.67

21:00 – 

22:00
1.00 0.69 0.85

10:00 – 

11:00
0.25 0.12 0.69

22:00 – 

23:00
1.00 0.38 0.71

11:00 – 

12:00
0.25 0.12 0.70

23:00 – 

24:00
1.00 0.16 0.58

 

 

Hotel (guest room) 

Cooling and heating setpoints, °C                               

CLG-SCHED,     
  Temperature,              
  Through: 12/31,           
  For: AllDays,             
  Until: 24:00,             
  24                   
 
HTG-SCHED,   
  Temperature,              
  Through: 12/31,           
  For: AllDays,             
  Until: 24:00,             
  21                     

Infiltration

All times 0.25  
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Occupancy, Lighting and Equipment

Time
Occ. 

(weekday)

Occ. (all 

other days)

Light. 

(weekday)

Light. (all 

other days)

Equip. 

(weekday)

Equip. (all 

other days)

24:00 – 

1:00
0.65 0.65 0.22 0.26 0.2 0.3

1:00 – 

2:00
0.65 0.65 0.17 0.26 0.2 0.3

2:00 – 

5:00
0.65 0.65 0.11 0.11 0.2 0.3

5:00 – 

6:00
0.65 0.65 0.22 0.11 0.2 0.3

6:00 – 

7:00
0.5 0.5 0.44 0.41 0.62 0.3

7:00 – 

8:00
0.28 0.34 0.56 0.41 0.9 0.62

8:00 – 

9:00
0.28 0.34 0.44 0.56 0.43 0.9

9:00 – 

10:00
0.13 0.2 0.44 0.56 0.43 0.62

10:00 – 

11:00
0.13 0.2 0.28 0.41 0.26 0.29

11:00 – 

12:00
0.13 0.2 0.28 0.33 0.26 0.29

12:00 – 

13:00
0.13 0.2 0.28 0.33 0.26 0.29

14:00 – 

15:00
0.13 0.2 0.28 0.33 0.26 0.29

15:00 – 

16:00
0.2 0.2 0.28 0.33 0.26 0.29

16:00 – 

17:00
0.35 0.2 0.28 0.33 0.26 0.29

17:00 – 

18:00
0.35 0.34 0.28 0.33 0.51 0.43

18:00 – 

19:00
0.35 0.35 0.67 0.85 0.51 0.51

19:00 – 

20:00
0.5 0.65 0.89 1 0.49 0.49

20:00 – 

21:00
0.5 0.65 1 1 0.66 0.66

21:00 – 

22:00
0.65 0.5 0.89 1 0.7 0.7

22:00 – 

23:00
0.65 0.5 0.67 0.85 0.35 0.35

23:00 – 

24:00
0.65 0.5 0.33 0.41 0.2 0.2

 

Occ. Light. Equip. Occ. Light. Equip.

All day 1 1 1 0 0 0

Time
Winter design daySummer design day
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Retail (point-of-sale) 

Cooling and heating setpoints, °C                               

CLG-SCHED,   

  Temperature,              

  Through: 12/31,           

  For: Weekdays SummerDesig 

  Until: 06:00,             

  30.0,                     

  Until: 21:00,             

  24.0,                     

  Until: 24:00,             

  30.0,                     

  For: Saturday,            

  Until: 06:00,             

  30.0,                     

  Until: 22:00,             

  24.0,                     

  Until: 24:00,             

  30.0,                     

  For WinterDesignDay,      

  Until: 24:00,             

  30.0,                     

  For: Sunday Holidays AllO 

  Until: 8:00,              

  30.0,                     

  Until: 19:00,             

  24.0,                     

  Until: 24:00,             

  30.0   

   

HTG-SCHED,   

  Temperature,              

  Through: 12/31,           

  For: Weekdays,   

  Until: 06:00,             

  15.6,                     

  Until: 21:00,             

  21.0,                     

  Until: 24:00,             

  15.6,                     

  For SummerDesignDay,      

  Until: 24:00,             

  15.6,                     

  For WinterDesignDay,      

  Until: 24:00,             

  21.0,                     

  For: Saturday,            

  Until: 06:00,             

  15.6,                     

  Until: 22:00,             

  21.0,                     
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  Until: 24:00,             

  15.6,                     

  For: Sunday Holidays All 

  Until:  8:00,             

  15.6,                     

  Until: 19:00,             

  21.,                      

  Until: 24:00,             

     15.6                    

Infiltration

Time

Infiltr. 

(week

day)

Infiltr. 

(Sat.)

Infiltr. 

(all 

other 

days)

24:00 – 

6:00
1 1 1

6:00 – 

8:00
0.5 0.5 1

8:00 – 

17:00
0.5 0.5 0.5

17:00 – 

21:00
0.5 0.5 1

21:00 – 

22:00
1 0.5 1

22:00 – 

24:00
1 1 1
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Time

Occ. 

(weekda

y)

Occ. 

(Sat.)

Occ. (all 

other 

days)

Light. 

(weekda

y)

Light. 

(Sat.)

Light. 

(all 

other 

days)

Equip. 

(weekda

y)

Equip. 

(Sat.)

Equip. 

(all 

other 

days)

24:00 – 

6:00
0 0 0 0.05 0.05 0.05 0.2 0.15 0.15

6:00 – 

7:00
0 0 0 0.05 0.05 0.05 0.2 0.15 0.15

7:00 – 

8:00
0.1 0.1 0 0.2 0.1 0.05 0.4 0.3 0.15

8:00 – 

9:00
0.2 0.2 0 0.5 0.3 0.1 0.7 0.5 0.3

9:00 – 

10:00
0.5 0.5 0.1 0.9 0.6 0.1 0.9 0.8 0.3

10:00 – 

11:00
0.5 0.6 0.2 0.9 0.9 0.4 0.9 0.9 0.6

11:00 – 

12:00
0.7 0.8 0.2 0.9 0.9 0.4 0.9 0.9 0.6

12:00 – 

17:00
0.7 0.8 0.4 0.9 0.9 0.6 0.9 0.9 0.8

17:00 – 

18:00
0.5 0.6 0.2 0.9 0.9 0.4 0.9 0.9 0.6

18:00 – 

19:00
0.5 0.2 0.1 0.6 0.5 0.2 0.8 0.7 0.4

19:00 – 

20:00
0.3 0.2 0 0.6 0.3 0.05 0.8 0.5 0.15

20:00 – 

21:00
0.3 0.2 0 0.5 0.3 0.05 0.7 0.5 0.15

21:00 – 

22:00
0 0.1 0 0.2 0.1 0.05 0.4 0.3 0.15

22:00 – 

24:00
0 0 0 0.05 0.05 0.05 0.2 0.15 0.15

 

Occ. Light. Equip. Infiltr. Occ. Light. Equip. Infiltr.

24:00 – 

6:00
1 1 1 1 1 0 0 1

6:00 – 

21:00
1 1 1 0.5 1 0 0 1

21:00 – 

24:00
1 1 1 1 1 0 0 1

Time
Summer design day Winter design day

 

School (classroom) 

Cooling and heating setpoints, °C                               

CLG-SCHED,   

  Temperature, 

  Through: 6/30, 

  For: SummerDesignDay, 

  Until: 24:00, 24, 

  For: WeekEnds Holidays WinterDesignDay, 
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  Until: 24:00, 27, 

  For: AllOtherDays, 

  Until: 06:00, 27, 

  Until: 21:00, 24, 

  Until: 24:00, 27, 

  Through: 9/1, 

  For: SummerDesignDay, 

  Until: 24:00, 24, 

  For: WeekEnds Holidays WinterDesignDay, 

  Until: 24:00, 27, 

  For: AllOtherDays, 

  Until: 07:00, 27, 

  Until: 18:00, 24, 

  Until: 24:00, 27, 

  Through: 12/31, 

  For: SummerDesignDay, 

  Until: 24:00, 24, 

  For: WeekEnds Holidays WinterDesignDay, 

  Until: 24:00, 27, 

  For: AllOtherDays, 

  Until: 06:00, 27, 

  Until: 21:00, 24, 

  Until: 24:00, 27; 

 

HTG-SCHED,   

  Temperature, 

  Through: 6/30, 

  For: WinterDesignDay, 

  Until: 24:00, 21, 

  For: WeekEnds Holidays SummerDesignDay, 

  Until: 24:00, 16, 

  For: AllOtherDays, 

  Until: 06:00, 16, 

  Until: 21:00, 21, 

  Until: 24:00, 16, 

  Through: 9/1, 

  For: WinterDesignDay, 

  Until: 24:00, 21, 

  For: WeekEnds Holidays SummerDesignDay, 

  Until: 24:00, 16, 

  For: AllOtherDays, 

  Until: 07:00, 16, 

  Until: 18:00, 21, 

  Until: 24:00, 16, 

  Through: 12/31, 

  For: WinterDesignDay, 

  Until: 24:00, 21, 

  For: WeekEnds Holidays SummerDesignDay, 

  Until: 24:00, 16, 

  For: AllOtherDays, 

  Until: 06:00, 16, 

  Until: 21:00, 21, 

  Until: 24:00, 16; 
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Infiltration, all days: 

All days, 24:00-7:00 1

All days, 7:00-21:00 0.5

All days, 21:00-24:00 1  

Occupancy, Lighting and Equipment

Weekdays

Time

Occ. 

9/2- 

6/30

Occ. 

7/1 - 

9/1

Light. 

9/2- 

6/30

Light. 

7/1 - 

9/1

Equip. 

9/2- 

6/30

Equip. 

7/1 - 

9/1

24:00 – 

7:00
0 0 0.1773 0.1773 0.35 0.25

7:00 – 

8:00
0 0 0.9 0.1773 0.35 0.25

8:00 – 

9:00
0.7 0.15 0.9 0.5 0.95 0.5

9:00 – 

10:00
0.7 0.15 0.9 0.5 0.95 0.5

10:00 – 

11:00
0.7 0.15 0.9 0.5 0.95 0.5

11:00 – 

12:00
0.7 0.15 0.9 0.5 0.95 0.5

12:00 – 

16:00
0.7 0.15 0.9 0.5 0.95 0.5

16:00 – 

17:00
0.15 0.15 0.9 0.5 0.95 0.5

17:00 – 

20:00
0.15 0.15 0.9 0.5 0.35 0.25

20:00 – 

21:00
0.15 0.15 0.9 0.1773 0.35 0.25

21:00 – 

24:00
0 0 0.1773 0.1773 0.35 0.25

 

Weekends and holidays

Time Occ. Light. 

Equip. 

9/2- 

6/30

Equip. 

7/1 - 

9/1

All day 0 0.1773 0.35 0.25  
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4.7.2.  Lighting control  

The lighting control logic is embedded in the program as illustrated in the diagram below: 

 

 

 

Figure 4-44.  Plan view of daylighting control sensors. 

 

 Daylight Illuminance:  The daylight illuminance setpoint is currently set at 50 footcandles. 

 Zone Depth:  A primary daylight zone depth is calculated as the minimum of a) the room depth, b) 
1.5 times the facade wall height, and c) 15 feet. 

 Sensor # 1:  Daylight sensor #1 is positioned 2/3 of the primary daylight zone depth from facade 
wall (centered in the width of the facade zone) and positioned at desk height: 2'-6" (0.76 m) above 
the floor. Sensor #1 controls a fraction of the facade zone lights equal to the primary daylight zone 
depth divided by the facade zone depth. 

 Sensor # 2:  Any remaining depth in the facade zone is considered a secondary daylight zone.  
Sensor #2 is positioned halfway between the primary daylight zone depth and the "back wall." 
Similar to sensor #1, the sensor is centered in the width of the facade zone and positioned at desk 
height: 2'-6" (0.76 m) above the floor. Sensor #2, if used, controls the remaining fraction of lights. 

The Lighting Control pulldown under the scenario edit screen contains three choices for lighting controls: 

  
 None: No lighting controls based on daylight levels. 
 Continuous:  Continuous lighting controls based on daylight levels.  

Min Power Fraction = 0.1 
Min Light Fraction = 0.05 
 

Front of facade  

Sensor # 1  

+  Centered between 
the left and right 
walls  

Positioned 2/3 of zone depth 
from front of facade 

Sensor # 2  
Centered in 
the zone +  

Daylighting Zone # 1 depth 
– the minimum of a) the 
room depth, b) 1.5 times 
the facade wall height, and 
c) 15 feet. 

Daylighting Zone # 2 
depth –total depth minus 
the Zone # 1 depth. 
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Figure 4-45.  Continuous light dimming based on daylight levels. 

(from the EnergyPlus Input/Output documentation) 

 

 Stepped:  Stepped lighting controls based on daylight levels. Min Power Fraction = 0, Min Light 
Fraction = 0, Number of Steps = 3, Probability of Reset = 1.0 (perfect occupants)  
 

 
Figure 4-46.  Stepped lighting controls based on daylight levels. 

(from the EnergyPlus Input/Output documentation) 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 




